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Overview

This chapter covers the following topics:

e (OVPI and ping tests: adding context to test results
e The Action Poller — a special collection mechanism
e Error messages in trend.log

e Ways to customize Cisco Ping reports

e  Sources for additional information

OVPI and Ping Tests: Adding Context to Test Results

If you want to know how well a network is performing, measure latency and reliability. If
latency is high, packets are not moving from source devices to destination devices as quickly
as possible. If reliability is low, packets are not reaching their intended destination. The
conventional approach to measuring latency and reliability is to conduct ping tests and watch
for poor results. The problem, however, is that the surrounding network is hidden from view.
You may have test results, but are your test results conclusive?

The Cisco Ping Report Pack contains reports that reveal the surrounding network, providing
context for the latency and reliability measurements produced by ping tests. With the
surrounding network in view, you have a clear picture of the conditions behind high latency
and low reliability. In addition, you will no longer have to guess what the load on an interface
is. You will know whether the load on the source router interface is about the same as the load
on the destination router interface, or whether the loads are completely different.

The Cisco Ping Report Pack will also enhance your SLA monitoring capability. If latency
breaches a threshold while utilization is high, the report pack will qualify this event as a non-
SLA breach. If latency or reliability crosses a threshold while utilization is low, the report
pack will qualify this event as an SLA breach.

Overview of Reports

Following is a brief description of the reports in Cisco Ping 4.0.

Executive Summary. Daily and hourly performance across all pairs. Displays aggregates for
the 95th percentile Round Trip Time and the Packet Delivery Ratio.




OVPI and Ping Tests: Adding Context to Test Results

Forecast. Ranks the worst performing pairs by daily 95th percentile Round Trip Time or by
total daily Packet Delivery Ratio. Drill down to baseline values, a daily summary, and
projections for F30, F60, and F90.

Worst Performing Pairs. Ranks pairs by daily 95th percentile Round Trip Time and by
Packet Delivery Ratio. Drill down to see interface utilization and CPU utilization for the
previous day.

Daily QuickView/Daily Snapshot. Ranks node pairs by RTT and delivery and provides
analysis of recent RTT and recent delivery; shows rolling baseline and rolling F30 forecast.
Drill down to hourly interface and CPU utilization.

Threshold Near Real Time QuickView/Threshold Near Real Time Snapshot. A rolling
summary of the previous six hours showing 95th percentile Round Trip Time and Packet
Delivery Ratio. Drill down to interface and CPU utilization.

Threshold Daily QuickView. Ranks node pairs by threshold breaches, shows recent Packet
Delivery Ratio, recent Round Trip Time, and compares rolling baseline to rolling F30
calculations. Drill down from summary information to hourly utilization data.

Threshold Summary Daily/Threshold Summary Monthly. Provides daily and monthly
totals for threshold breaches for every node pair. Shows threshold settings, exception details,
SLA qualifications in effect at the time of the exception; tracks changes in the daily SLA
threshold count and daily non-SLA threshold count for the last 30 days.

Version History

Version 3.0 of the Cisco Ping Report Pack was released October 2003. Version 3.0 installed on
OVPI 4.6 and supported OVPI Object Manager. Version 3.0 included the following forms.

e Configure Collection Group

Create a collection group containing a list of related Cisco Ping device pairs.
e Configure Device Pairs

Add new Cisco ping source and destination device pairs to a collection group.
e C(Create Device Pair Parameters

Create new parameters for a device pair. Parameters pertain to parameter count, package
size, package timeout, and delay.

e Update Device Pair Parameters

Modify the parameters created using the create parameters form.
e Update Thresholds

Modify the following threshold values:

— RTT

— Discard

— CPU utilization

— Interface utilization

Version 4.0 was released in April 2004. The only enhancements in version 4.0 pertained to
compatibility with OVPI 5.0. There were no new reports, no new forms, and no changes to
existing reports. Version 4.0 was released unchanged in August 2004 with RNS 6.0. Version
4.0 was released again in November 2004 with RNS 7.0.
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Integration with Network Node Manager

If you have Network Node Manager, and your NNM server is already integrated with OVPI,
the trending analysis produced by the Cisco Ping package will integrate smoothly with the
fault management capabilities of Network Node Manager. There are two ways that the NNM
operator will come into contact with Cisco Ping reports:

Scenario 1. Cisco Ping sends a threshold trap to NNM. The NNM operator sees an alarm in
the NMM alarm browser. The NNM operator can respond to that alarm by launching the
Cisco Ping Near Real Time report.

Scenario 2. The NNM operator is not seeing threshold breaches from Cisco Ping; however,
the operator wants to investigate more closely a device that Cisco Ping is monitoring. The
operator will find Cisco Ping reports listed among other OVPI reports in the Report
Launchpad window. This window can be opened from:

¢ NNM ovw
e Home Base Dynamic Views

e NNDM alarm browser

The Action Poller — A Special Collection Mechanism

Most OVPI report packs use a collection mechanism that collects data from single nodes, is
built into OVPI, and operates transparently. The Cisco Ping Report package is different. It
has its own collection mechanism—the Action Poller—that collects data from pairs of nodes as
opposed to single nodes. Before collection can take place, you must define node pairs using the
Action Poller User Interface.

Guidelines for a Successful Collection

Action Poller collections are governed by the following rules and restrictions:

e A node pair consists of a source node and a destination node. Source and destination
nodes must be discovered. Source and destination nodes that have been discovered will be
filtered by the Action Poller User Interface into lists for selection.

e The source node must be a Cisco router that supports the Cisco Ping MIB or is currently
running the Cisco Ping agent, IOS 10.2 or later.

e The write community string for the source node must be correct.

e The Action Poller will perform an SNMP set on the source node. If the SNMP set fails, the
node pair collection will fail.

¢ The destination node must be an SNMP device.

e Any node that is unreachable, unavailable, or not properly configured will generate an
error message in the {DPIPE_HOME}\OVPI\log\trend. log file.

) Re-indexing events that affect the interfaces on a device should be tracked
through the datapipe that is being used to inherit node instance information.
Analyze and track these events as necessary.




The Action Poller — A Special Collection Mechanism

MIBs and Metrics

Every polling cycle, the Action Poller collects ping statistics once and interface and CPU
statistics twice. The sequence is:

1 Collect interface and CPU utilization data.
2 Collect ping test data.

3 Collect interface and CPU utilization data.
The Action Poller collects data from the following MIBs:
e C(Cisco Ping MIB

e (Cisco System MIBlet

e Interface Reporting Basic Info MIBlet

The Action Poller returns the following metrics:
e Average round trip time

e  Minimum round trip time

e Maximum round trip time

e Packet delivery ratio

e Interface utilization

e CPU utilization

The following factors influence the metrics returned by the Action Poller:
¢ CPU load on the source node

e CPU load on the destination node

e Competing user traffic on node interfaces

e Packet size

e Network configuration

e Network load

By configuring Cisco Ping MIB parameters and the frequency of polling, you can collect
metrics that simulate the delay experienced by user traffic between node pairs. By correlating
delay samples with other metrics, you can determine which factors are contributing to delay.

) You cannot set various Ping MIB parameters on the source node or initiate
pings unless the write community string is correctly specified. Use Polling
Policy Manager to modify the write community string on specific nodes.

Packet Delivery Ratios

A source node that supports a ping MIB can be instructed (by means of SNMP SET requests)
to send a defined series of ping messages to a destination node. The source node logs the
following metrics:

e Number of attempted pings

e Number of successful pings

10
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e Round trip delay (min, max, and average) for successful pings

If the number of successful pings is less than the number of attempted pings in the ping
sequence, one of the nodes in the node pair, or possibly the network in between, discarded the
ping request or the returning ping response. Several factors can cause a ping to be
unsuccessful:

e Network delay that exceeds the configured ping timeout on the source node
e High CPU load on either the source or destination node

e High traffic loads on the interfaces and/or sub-interfaces of either the source or
destination node competing with the ping traffic

e Packet size—larger packets are more susceptible to discard

¢ The network configuration—traffic management, buffer sizes, and line speeds, among
other factors

e Network load—congested links, congested switching, and routing resources

Factors that influence network delay can also influence the network discard rate. In general,
depending on how the network is configured to handle queuing and traffic management,
overutilization of bandwidth or processing resources can cause delay and discards.

By configuring the Cisco Ping MIB parameters and sampling frequency, you can collect
metrics that represent the general delivery/discard characteristics of the traffic between node
pairs. You can also correlate packet delivery ratios with other metrics, such as CPU load or
buffer size, and determine why packets are being discarded.

Route Availability

If no ping in a given sample is successful, then (1) connectivity between the source and
destination node was unavailable or (2) the destination node was unavailable when the test
took place. An unavailable route can be caused by any of the following:

e Network configuration error—routing, firewalls, proxies, and so on
¢ Chronic network congestion—packet discard ratio at 100%

e Network/PVC failure

¢ Remote node is down

By configuring Cisco Ping MIB parameters and the frequency of sampling, you can collect
data to compute representative availability on the routes between node pairs. You can also
routinely poll the source and destination nodes at the time of the ping sampling. This will tell
you whether nodes, or the network between the nodes, is causing an availability problem.

Error Messages in trend.log

Not all of the errors that appear in trend. log are error messages. The following messages
contain supplemental information only and can be ignored:

e Messages produced during package installation that refer to tables that are dropped and
then recreated. If a table does not exist, and there is an attempt to drop the table, a
message will be generated.
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e Messages produced when the object SQL script attempts to load certain database objects
that have already been loaded by the Common Property Tables package.

e Messages produced during each polling cycle.
Here are a few examples of messages written during each polling cycle:

2004-03-15 14:30:59:000,Eastern Standard Time, -

5:00,bcpfile, ,ERROR,2572,2668,0,"DB_ERR 0, OS_ERR 0, SEVERITY 0, SPID O,
dbErrStr [DataDirect] [ODBC Sybase Wire Protocol driver]No upload tables exist,
using original table Risco_ping_rtd_, osErrStr 01000"

2004-03-15 14:30:59:000, Eastern Standard Time, -
5:00,bcpfile, ,ERROR,2572,2668,0, "Failing command"

2004-03-15 14:30:59:000, Eastern Standard Time, -
5:00,bcpfile, ,ERROR,2572,2668,0,"{call dsi_lock upload_table_p(?, 2, ?, 2?2, ?)}"

Ways to Customize Reports

Reports can be customized by applying group filters, importing customers and locations,
editing parameters, and editing tables and graphs. Group filters are used by service providers,
or any organization that wants to share reports with customers. Any user can apply
constraints to a report or edit tables and graphs. For details about view options for tables and
graphs, see Chapter 15, Editing Tables and Graphs.

Group Filters

If you want to share reports with customers, you must produce customer-specific reports.
Producing customer-specific reports involves the following steps:

e Importing customers and locations using Common Property Tables
e C(Creating a group account for all of the users affiliated with a particular customer
e Creating a group filter for the group account

For more information about creating filters for group accounts, refer to the Performance
Insight 5.0 Administration Guide.

Editing Parameters

Editing a parameter applies a constraint to the report. The constraint filters out data you do
not want to see. For example, if you edit the Customer Name parameter, data for every
customer except the customer you typed in the Customer Name field will drop from the
report. Cisco Ping 4.0 supports the following parameters:

e (Customer Name
e (Customer_Id

e Location_Name
e TLocation_Id

e  Source

e Destination

12
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If you are using the Web Access Server to view reports remotely, edit parameters by clicking
the Edit Parameters icon at the bottom right-hand corner of the report. When the Edit
Parameters window opens, enter the constraint in the field and click Submit.

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the
Modify Parameter Values window opens, click the Current Value field. Type a new value and
click OK.

Sources for Additional Information

This user guide provides samples of some reports, but not all of them. The demo package that
comes with Cisco Ping 4.0 contains a sample of every report in the package. If you have access
to the demo package and you want to know what fully-populated reports look like, install the
demo package. Like real reports, demo reports are interactive. Unlike real reports, demo
reports are static.

For information regarding the latest enhancements to the Cisco Ping package and any known
issues, refer to the Cisco Ping Report Pack 4.0 Release Statement. You may also be interested
in the following documents:

e [Interface Discovery Datapipe 2.1 User Guide

e Thresholds Module 5.0 User Guide

e NNM / Performance Insight Integration Module 2.0 User Guide
e RNS 7.0 Release Notes, November 2004

Manuals for the core product (OVPI) and manuals for the reporting solutions that run on
the core product can be downloaded from the following web site:

http:/www.hp.com/managementsoftware

Select Support > Product Manuals to reach the Product Manuals Search page. User guides for the
core product are listed under Performance Insight. User guides for report packs, datapipes,
preprocessors, and value-add components for NNM are listed under Reporting and Network
Solutions.

The manuals listed under Reporting and Network Solutions indicate the month and year of
publication. If a user guide is revised and reposted, the publication date will change even if
the software version number does not change. Since we post revised user guides on a regular
bases, you should search this site for updates before using an outdated manual.
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The Upgrade Install

This chapter covers the following topics:
e Guidelines for a smooth upgrade
e Using Package Manager to install the upgrade package

e Package removal

If you are installing Cisco Ping for the first time, see Chapter 3, The New Install.

Guidelines for a Smooth Upgrade

The RNS CD includes components for NNM as well as report packs and datapipes for OVPI.
When you insert the CD, launch the package extraction interface, and select OVPI report
packs for installation, the install script extracts every OVPI package from the CD and copies
the results to the Packages directory on your system. After the extract process finishes, the
install script prompts you to launch Performance Insight and start Package Manager. Before
starting Package Manager, review the following guidelines.

Prerequisites for the Upgrade
The following software must already be installed before upgrading from Cisco Ping 3.0 to
Cisco Ping 4.0:
e OVPI5.0
e All service packs available for OVPI 5.0
e (Cisco Ping Report Pack 3.0
e Interface Discovery Datapipe 2.0 or higher

You can find information about each service pack, including installation instructions, in the
release notes for the service pack.

15



Upgrading Cisco Ping 3.0 to Cisco Ping 4.0

Distributed Environments

If you are running Cisco Ping in a distributed environment, the central server, every satellite
server, and every remote poller must be running OVPI 5.0. Following is an overview of the
upgrade procedure for a distributed environment:

1 Disable trendcopy on the central server.
2 Ifyou are running version 1.1 of the Interface Discovery Datapipe, remove it.
3 Install the upgrade package for the report pack; deploy reports.
4 Install these packages simultaneously:
¢ Thresholds sub-package (optional)
e Interface Discovery Datapipe 2.0 or higher
5 For each satellite server:
a Remove version 1.1 of the Interface Discovery Datapipe.
b Install the upgrade package for the report pack; do not deploy reports.
¢ Install these packages simultaneously:
- Thresholds sub-package (optional)
- Interface Discovery Datapipe 2.0 or higher

6 Enable trendcopy on the central server.

Integration with NNM: Threshold Alarms

If you have already integrated OVPI with NNM, you will probably want to install the optional
thresholds sub-package, Ping MIB_Threshold, on the OVPI server. If this package is
installed, threshold breaches spotted by OVPI will become threshold traps sent to your NNM
server, where traps will appear as alarms in the NNM alarm browser.

The thresholds sub-package cannot operate unless the Threshold and Event Generation
Module, commonly known as the Thresholds Module, is also installed. If you are not running
any version of the Thresholds Module, let Package Manager install the latest version for you,
automatically.

Upgrading Cisco Ping 3.0 to Cisco Ping 4.0

Perform the following tasks to upgrade Cisco Ping 3.0 to Cisco Ping 4.0:

e Task 1: Stop OVPI Timer and extract packages from the RNS product CD

e Tagk 2: If you are running version 1.1 of the Interface Discovery Datapipe, remove it
e Task 3: Install version 2.0 of the Interface Discovery Datapipe

e Task 4: Install UPGRADE_Cisco_Ping_3_to_4

e Task 5: Install the thresholds sub-package (optional)

16



Chapter 2

Task 1: Stop OVPI Timer and extract packages from the RNS CD
1 Log in to the system. On UNIX systems, log in as root.
2 Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS product CD. On Windows, a Main Menu displays automatically; on UNIX,
mount the CD if the CD does not mount automatically, navigate to the top level directory
on the CD, and run the ./setup command.

4 Type 1in the choice field and press Enter. The install script displays a percentage complete
bar. When the extract is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

After the copy to the Package directory is complete, you have the option of navigating to the
Packages directory to see the results. Under the Ping MIB folder, you will see the following
folders:

e Ping MIB.ap

e Ping MIB_Demo.ap

e Ping MIB_Thresholds.ap

e UPGRADE_Ping MIB_3_to_4.ap

Installing the demo package is optional. You may install the demo package by itself, with no

other packages, or you may install the demo package along with everything else.

Task 2: Uninstall the Interface Discovery Datapipe 1.1

1 Click Next. The Package Location window opens.

2 Click Uninstall.

3 Click Next. The Report Undeploy window opens.

4 Click the check box next to the following packages:
IFEntry_Disc_Datapipe 1.1
IR_ifEntry_Datapipe 1.1

5 Click Next. The Selection Summary window opens.

6 Click Uninstall. The Progress window opens and the removal begins. When the uninstall
process is complete, a package removal complete message appears.

7 Click Done to return to the Management Console.

17



Upgrading Cisco Ping 3.0 to Cisco Ping 4.0

Task 3: Install the Cisco Ping 3.0 to 4.0 Upgrade Package

1 From the Management Console, select Tools > Package Manager. The Package Manager
welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or select a different directory if
necessary.

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the OVPI Application Server.

5 Click Next. The Package Selection window opens.

6 Click the check box next to the following package:
UPGRADE_Ping_MIB_3_to_4

7  Click Next. The Type Discovery window opens. Disable the default.

8 Click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

10 Click Done.

) Do not be surprised if the UPGRADE package you just installed seems to
have disappeared from Package Manager. Package Manager displays what
you just installed as Cisco Ping 4.0.

Task 4: Install the Thresholds Sub-Package and restart OVPI Timer

1 Start Package Manager. The Package Manager welcome window opens.

Click Next. The Package Location window opens.

Click Install.

Click Next. The Report Deployment window opens; disable the option to Deploy Reports.
Click Next. The Package Selection window opens.

o a A~ W N

Click the check box next to the following packages:
Cisco_Ping_Thresholds

7 Click Next. The Type Discovery window opens.

8 Disable the default and click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install begins. When the
install finishes, a package install complete message appears.

10 Click Done to return to the Management Console.
11 Restart OVPI Timer.

18
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On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Package Removal

If you remove a report pack, the associated tables and all the data in those tables will be
deleted. If you want to preserve the data in those tables, archive the data before removing the
package.

Follow these steps to remove the Cisco Ping Report Pack.

1
2

N o g o~ W

10
11

Log in to the system. On UNIX systems, log in as root.
Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeployment window opens.
Click the check box next to the following packages:
Ping_MIB
Ping MIB_Thresholds (if installed)
Ping_MIB_Demo (if installed)
Click Next. The Selection Summary window opens.

Click Uninstall. The Progress window opens and the removal begins. When the removal
finishes, a package removal complete message appears.

Click Done.
Restart OVPI Timer.
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Package Removal

On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

20



The New Install

This chapter covers the following topics:

¢  Guidelines for a smooth installation

e Using Package Manager to install Cisco Ping 4.0
e Accessing deployed reports

e Package removal

Guidelines for a Smooth Installation

The RNS CD includes components for NNM as well as report pack and datapipes for OVPI.
When you insert the RNS CD, launch the package extraction interface, and select OVPI report
packs for extraction, the install script extracts every OVPI package from the CD and copies
the results to the Packages directory on your system. After the extract process finishes, the
install script will prompt you to start Package Manager. Before starting Package Manager,
review the following guidelines.

Prerequisites for Package Installation

The following software must already be installed before installing Cisco Ping 4.0:
e OVPI5.0

¢ Any available service packs for OVPI 5.0

e Interface Discovery Datapipe 2.0 or higher

You can find information about each service pack, including installation instructions, in the
release notes distributed with the service pack.

) The Interface Discovery Datapipe is a prerequisite for the IR ifEntry
Datapipe. If you are running version 1.1 of the Interface Reporting ifEntry
Datapipe, remove version 1.1 and install version 2.0 or higher.

21
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Distributed Environments

If you are running Cisco Ping in a distributed environment, the central server, every satellite
server, and every remote poller must be running OVPI 5.0. Following is an overview of the
installation procedure for distributed environments.

Central Server

1 Ifyou are running version 1.1 of the Interface Discovery Datapipe, remove it.
2 Install the following packages simultaneously:

e (Cisco Ping; deploy reports

e (Cisco Ping thresholds sub-package (optional)

e Interface Discovery Datapipe 2.0 or higher

Each Satellite Server

1 Ifyou are running version 1.1 of the Interface Discovery Datapipe, remove it.
2 Install the following packages simultaneously:

e (Cisco Ping

e (Cisco Ping thresholds sub-package (optional)

e Interface Discovery Datapipe 2.0 or higher

Integration with NNM: Threshold Alarms

If OVPI and NNM are already integrated, you will probably want to install the optional
thresholds sub-package (Cisco_Ping_Thresholds) on the OVPI server. If this package is
installed, a threshold breach spotted by OVPI will become a threshold trap sent to the NNM
server, where the trap will appear as an alarm in the NNM alarm browser.

The thresholds sub-package cannot operate unless the Threshold and Event Generation
Module, commonly known as the Thresholds Module, is also installed. You may be running
the previous version of the Thresholds Module. If you are running the previous version, you
must upgrade to the latest release. For more information about recent enhancements to this
package, refer to the Thresholds Module 5.0 User Guide.

Installing Cisco Ping 4.0

Perform the following tasks to install Cisco Ping 4.0:
e Task 1: Stop OVPI Timer and extract packages from the RNS CD
e Task 2: If you are running version 1.1 of the Interface Discover Datapipe, remove it
e Task 3: Install these packages simultaneously:
— Cisco_Ping
— Cisco_Ping_Thresholds
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Task 2:

Chapter 3

— Cisco_Ping_Demo (optional)
— IFEntry_Disc_Datapipe 2.0 or higher
— IRifEntry_Datapipe 2.0 or higher

Stop OVPI Timer and extract packages from the RNS CD
1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.

On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the RNS product CD. On Windows, a Main Menu displays automatically; on UNIX,
mount the CD if the CD does not mount automatically, navigate to the top level directory
on the CD, and run the ./setup command.

4 Type 1in the choice field and press Enter. The install script displays a percentage complete
bar. When the copy is complete, the install script starts Package Manager. The Package
Manager welcome window opens.

After the copy to the Package directory is complete, you can navigate to the Packages
directory to see the results. Under the Ping_MIB folder you will see the following folders:

e Ping MIB

e Ping MIB_Thresholds

e Ping MIB_Demo

e UPGRADE_Ping MIB_3_to_4

Ignore the upgrade package. Installing the demo package is optional. You may install the
demo package by itself, with no other packages, or you may install the demo package along
with everything else.

Uninstall the Interface Discovery Datapipe 1.1

1 Click Next. The Package Location window opens.
2 Click Uninstall.
3 Click Next. The Report Undeployment window opens.
4  Click Next. The Package Selection window opens.
5 Click the check box next to the following packages:
IR_ifEntry_Datapipe 1.1
IFEntry_Disc_Datapipe 1.1

6 Click Next. The Selection Summary window opens.
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Task 3:

7

8

Click Uninstall. The Progress window opens and the removal begins. When the removal
finishes, a package removal complete message appears.

Click Done to return to the Management Console.

Install Cisco Ping 4.0, associated datapipes, and restart OVPI Timer

1

10
11

Start Package Manager, if it is not already started. The Package Manager welcome
window opens.

Click Next. The Package Location window opens.
Click Install.

Click Next. The Report Deployment window opens. Accept the default for Deploy Reports;
accept the defaults for application server name and port. Type your user name and
password for the OVPI Application Server.

Click Next. The Package Selection window opens.
Click the check box next to the following packages:
Cisco_Ping 4.0
Cisco_Ping_Thresholds
Cisco_Ping_Demo
IRifEntry_Datapipe 2.1
IFEntry_Disc_Datapipe 2.1
Click Next. The Type Discovery window opens; accept the default.
Click Next. The Selection Summary window opens.

Click Install. The Installation Progress window opens and the install begins. When the
install completes, a package install complete message appears.

Click Done.
Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

24



Chapter 3

Accessing Deployed Reports

Before reports can be viewed, they must be deployed. When you installed the Cisco Ping
Report Pack, you enabled the Deploy Reports option. As a result, the reports in this package
(as well as any forms that come with the package) were deployed to the OVPI Application
Server. Once reports and forms reside on the OVPI Application Server, you have two ways to
view them:

e (OVPI clients
e  Web browser

If the client components are installed on the user’s system, the user has access to Report
Viewer, Report Builder, and the Management Console. If the client components are not
installed on the user’s system, using a web browser to view reports is the only way the user
can view reports.

For more information about the client components, refer to the Performance Insight
Installation Guide. For more information about the Management Console, including how to
use the Object/Property Management view to launch reports specific to a selected object, refer
to the Performance Insight Administration Guide.

Package Removal

If you remove a report pack, the associated tables and all the data in those tables will be
deleted. If you want to preserve the data in those tables, archive the data before removing the
package.

Follow these steps to remove Cisco Ping 4.0.
1 Log in to the system. On UNIX systems, log in as root.
2  Stop OVPI Timer and wait for processes to terminate.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Stop.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer stop
Sun: sh /ete/init.d/ovpi_timer stop
Start Package Manager. The Package Manager welcome window opens.
Click Next. The Package Location window opens.
Click Uninstall.
Click Next. The Report Undeployment window opens.

Click Next. The Package Selection window opens.

0 N o a0 s~ W

Click the check box next to the following packages:
Cisco_Ping
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Cisco_Ping_Thresholds (if installed)
Cisco_Ping_Demo (if installed)
9 Click Next. The Selection Summary window opens.

10 Click Uninstall. The Progress window opens and removal begins. When removal finishes, a
package removal complete message appears.

11 Click Done.
12 Restart OVPI Timer.
On Windows, do the following:
a Select Control Panel > Administrative Tools > Services.
b Select OVPI Timer from the list of services.
¢ From the Action menu, select Start.
On UNIX, as root, do one of the following:
HP-UX: sh /sbin/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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This chapter covers the following topics:

¢ Launching the Action Poller User Interface
¢ Defining node pairs

e MIBlet groups

e Assigning instances to nodes

e Modifying parameter sets

e Exiting the interface

Launching the Interface

The Action Poller User Interface resides in the $DPIPE_HOME/bin directory. To invoke the
interface, type the following command at the command prompt:

Windows: action_config
UNIX: action_config.sh

The Configure Action Poller window opens. If any collection group, including the default Cisco
Collection, has already been defined, it will appear in this window.

To add a new collection group, click New. To modify an existing collection group definition,
highlight the collection you want to modify and click Modify. The New Action Collection Group
window opens. Follow these steps to define a collection group:

1 Enter the collection group name in the Collection Group field. If you are modifying an
existing collection group definition, the name is displayed in the Collection Group field
and the field is grayed out.

2 After the configuration is complete, enter the name of the host on which the Action Poller
is to run in the Poller Name field.

3 After the new or modified collection is finished, click Save and then click Node Pairs to
open the Node Pair Properties window.

The Action Poller can be configured for distributed polling. For example, you can define
collection group_1 to run on poller A, collection group_2 to run on poller B, and so on. During
the initial configuration, you can leave the Poller Name set to the value of hostname.
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Defining Node Pairs

Highlight any node pair on the Node Pair Properties screen and click Remove to modify the
list of current node pairs assigned to the collection. You may also remove all node pairs.
Clicking Add opens the Add Node Pairs window.

All nodes that are known to OVPI appear in the Available Nodes list box. If the nodes you
want to select are not listed, use Polling Policy Manager to add them and perform a type
discovery from the command prompt using the command: trend_discover -t

Follow these steps to add a new node pair to the collection group:

1

From the Add Node Pairs window, highlight one node that is to be a source node in the

Source Nodes list box. The source node must be a Cisco Router capable of performing an
SNMP set.

Click Make Source to assign the node to the Source Node text box.
Select one node that is to be a destination node from the Destination Nodes list box.

Click Make Destination to assign the node to the Destination Node list box. You can select
several destination nodes for a single Source Node to quickly make node pairs using the
same Source Node.

Click Make Pairs to pair the selected source node with each node that is listed in the
Destination Nodes list box.

The node pairs you define are added to the New Node Pairs list box at the bottom of the
window. The same node can be the source node of one or more pairs and the destination
node of one or more pairs. Each distinct pair of nodes can be added only once per
collection. If you want to collect data from different interfaces on the nodes, set up a new
collection with the same pair of nodes.

If you want to remove a node pair from the new node pairs list box, highlight the node pair
and click Remove Node Pair. The selected pair is removed from the Source-Destination list.

Continue to create as many node pairs as you want to assign to this particular collection
group. When you finish, click Add Node Pairs. To exit, click Close.

MiBlet Groups

A MIBlet group is a named set of MIBlets that you want to collect as a group at a source or
destination node. The Cisco Ping Report Pack always uses the Cisco collection MIBlet and
cannot be modified. This group comprises the following two MIBlets:

interface_rtd_png_

xcpu_util_rtd_png_

These MIBlets correspond to the following standard OVPI MIBlets:

interface-reporting_basic_interface_info

cisco_system
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Assigning Instances to Nodes

Use the Node Pair Properties window to assign the appropriate instance to the source and
destination nodes of each node pair you defined. Multiple instances of MIBlet objects can be
collected from a node depending on the nature of the MIBlet. An instance corresponds to a
unique interface on the node. For example, a separate instance of the

interface_reporting basic_interface_info MIBlet is collected for each interface on a node.

Other MIBlets, such as the cisco_system MIBlet, are collected at the node level, rather than
interface level, and return a single set of values for the node. Data that is interface-specific
will not be collected if an instance has not been assigned.

Follow these steps to assign source and destination collection instances for each node pair:

1
2

Highlight a node pair in the list box.

The MIB-2 Interface Source and Destination instances are initially set to NULL,
indicating that the MIBlet instances to be collected for the source and destination nodes
have not been assigned yet.

The instances of the selected MIBlet that can be collected for the source and destination
nodes of the selected pair appear in the Source MIBlet Instances and Destination MIBlet
Instances list boxes, respectively.

) Instance data is inherited from the GENMIB2IF Datapipe or the Interface
Discovery Datapipe. Unless one of these datapipes has collected at least two
poll cycles of data, the list boxes will contain no instances. You may also
import property information, in batch fashion, to add and modify node pair
information.

Select the source instance to be collected by clicking the instance listed in the Source Node
Instances list box.

Click Assign Source. Note that the selected instance is displayed in the Src Inst column of
the Source and Destination Instance Info list box.

Select the destination instance to be collected by clicking the instance listed in the
Destination Node Instances list box.

Click Assign Destination Instance.

Repeat this procedure to assign the appropriate source and destination instance of each
MIBIlet associated with each node pair you have assigned to this collection group.

Click Save when finished.

Modifying Parameter Sets

To modify parameter sets, click Parameter Sets on the Node Pair Properties window and
perform any of these tasks:

Modify an existing parameter set
Create a new parameter set

Remove a parameter set

29



Exiting the Interface

You may assign the parameter set to an individual node pair or all node pairs. Close the
window when finished by clicking Close.

The following table defines each parameter and indicates what you can specify.

Parameter Description

Packet Count Number of packets to send during each ping
action. Specify from 1 to 2147483647 (2 GB).

Packet Size Number of bytes in each packet. Specify from 1 to
2147483647 (2 GB).

Packet Timeout Milliseconds to wait for a reply from the
destination node. Specify from 0 to 3600000.

Delay Milliseconds to wait between ping actions. Specify
from 0 to 3600000.

Exiting the Interface

You can terminate the interface in either of these ways:
e (Click Close on the initial collection window.
* Select File > Exit.

Any specifications you have made up to that point will be saved as part of the current
collection group.
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Configuration Options

This chapter provides information about the following configuration options:
e Configuring servers in a distributed system

e Provisioning the property table

e Action Poller command line options

¢ Changing the collection interval

Configuring Servers in a Distributed System

If you intend to run Cisco Ping in a distributed system, you have already installed the report
pack on the central server and on each satellite server. You also deployed reports once, from
the central server. Now that installation is complete, perform the following tasks:

e Set up connections between the central server and each satellite server database.
e At the central server, configure trendcopy pull commands for hourly data.
e At each satellite server, disable daily summaries.

In addition to performing these tasks, verify that the system clock on the central server is
synchronized with all other system clocks, and make sure that you do not have two servers
polling the same device.

Configuring the Central Server

Follow these steps to configure the central server:
1 Start the Management Console.
2 C(Click the Systems icon on the lower left. The System/Network Administration pane opens.

3 Right-click the Databases folder. When prompted, select Add OVPI Database. The Add
Database Wizard opens.

4 Click Next.
5 Type the hostname and port number for the database you want to add; click Next.

6 Review the Summary. Repeat Steps 4 and 5 for each additional database.
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7 Click Finish when you finish adding databases.

8 Configure trendcopy pull commands from the central server to each remote satellite. Do
this by editing the {DPIPE_HOME}/scripts/Ping_MIB_Sum.pro file. Make sure that
you add all the trendcopy commands you need, and make sure that each command
includes the correct name for the satellite server.

9 Comment out the hourly summary. This function belongs to satellite servers.

10 Modify the Ping MIB_Sum.pro trendtimer entry as shown in the {DPIPE_HOME} /
scripts/Ping_MIB_Sum.pro file. Changing the start time will prevent the central
server from pulling data from satellite servers when they are busy summarizing data.

Configuring a Satellite Server

Follow these steps to configure a satellite server.

1 Switch off summaries above the hourly level by editing the $SDPIPE_HOME/1lib/
trendtimer . sched file; comment out the line referencing Ping MIB_Daily.pro.

2 Comment out the trendcopy pull commands in the {DPIPE_HOME} /scripts/
Ping_MIB_Sum.pro file. Uncomment the hourly summary.

3 Make sure that the system clock on each satellite server is synchronized with the system
clock on the central server.

Provisioning the Property Table

Provisioning the property table is optional. If you want to aggregate data by customer or by
region, or change default threshold settings, provisioning is mandatory. If you are a service
provider and you want to share your reports with customers, provisioning is mandatory.
Threshold values are already defaulted, so provisioning those values is necessary only if you
want to modify the default.

If you do not want to use the Action Poller User Interface to enter node pairs, consider using
the property provisioning mechanism. As the property table is provisioned, any node pairs
that already exist will have customer and threshold information updated. If the node pair
does not exist, it will be created. You should use the interface to delete node pairs.

) If you do not provision the property table, the term unassigned will appear in
any list of customers or regions.

This section covers the following topics:
e K IFEntry_Disc table

e action_property_table file

¢ Format of the import file

e Changing defaults

e Initializing property tables
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K_IFEntry_Disc Table

The Cisco Ping Report Pack looks for the K_IFEntry_Disc property table. This table is created
by the Interface Discovery Datapipe. However, you are not required to use this particular
property table or the Interface Discovery Datapipe. If desired, a different property table from
another report pack or datapipe can be used instead.

The Cisco Ping Report Pack can inherit interface information from the GENMIB2IF_ifentry
Datapipe. If that is what you want to happen, the correct name of the property table to place
in the action_property_table file is K_ GENMIB2IF_ifentry. After the Action Poller user
interface has launched, only interfaces that have been discovered, and interfaces that have
collected interface data, will display node instance information.

action_property_table

The Cisco Ping Report Pack will look for the action_property_table file in the
{DPIPE_HOME}\OVPI\1lib directory. The contents of the action_property_table file must
contain the exact name of the correct property table. Make sure the name for the
action_property_table file does not include a file extension such as . txt.

Format of the Import File

While interface instance information can be inherited from the Interface Discovery Datapipe,
the following properties must be imported manually using the provisioning interface:

e Customer

e Region

¢ Round Trip Time Threshold Values

e Packet Delivery Ratio Threshold Values

e Interface Utilization Threshold Values

e Interface CPU Utilization Values

To import this information, create a flat file that contains property information and then
import the file. Follow these steps:

1 Create a property import file using the format described below.
2 Give the file this name: Ping_MIB_Property.dat

3 Place the file in the following directory:

{DPIPE_HOME} /Packages/PING_MIB/Ping_MIB.ap/PropertyData

) This file, which will not be deleted or moved, may also serve as a record of
“node ping pairs” currently associated with property data. If you wish to add
node ping pairs, modify this file and save it to the same directory specified
above. The process runs daily and will not affect existing property values. Be
aware that duplicate node ping pairs may cause undesirable results in the
assignment of property data values.
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Provisioning the Property Table

Your property import file is a tab-delimited file. There are no column headings. When you
create it, be sure to include all the columns listed in the table below, and be sure the sequence
of your columns left to right follows the sequence in the table top to bottom.

n
o
(=]

Column Name

Description

src_rtr_name

Source node name

src_cpu_instance

CPU instance for the source node

src_if instance

Source node interface instance

dst_rtr_name

Destination node name

dst_cpu_instance

CPU instance for the destination node

dst_if instance

Destination node interface instance

cust_id

Unique integer value for each customer

customer_name

Customer name associated with cust_id

©C |0 | | || x| W | N

region_id

Unique integer value for each region

—
o

region_name

Region name associated with region_id

11

rtt_threshold

Round trip time threshold in milliseconds

12

discard_threshold

Packet discard percentage (0-100) threshold

13

interface threshold

Interface utilization threshold

14

cpu_threshold

CPU threshold

If you are unsure of the format or if the import fails, consider exporting existing property
information from OVPI. Edit the file exported by OVPI, then re-import the new file.

Changing Defaults Related to Property Import

The default directory for property data files, the location where the import utility will look for
your edited files, is specified by the SourceDirectory path. This path appears in the following

TEEL file:

Ping_MIB_Property.teel

If you are changing the default directory before you install the Cisco Ping Report Pack, you
can locate the TEEL files in the Ping_MIB. ap directory. If you want to change the default
directory after running Package Manager, you must change the path information in two

directories:

® Ping MIB.ap

e {DPIPE_HOME}/lib
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SourceDisposition

The default for SourceDisposition is keep. Keeping the existing file in place allows the
administrator to identify existing ping pairs that are already provisioned. The disposition of
this file is determined by a directive in the Ping_MIB_Property. teel configuration file. If
desired, you may elect to have the file moved or deleted.

SourceDirectory

To change the SourceDirectory, do the following:
1 Create the new source directory.

2 Navigate to the appropriate directory (see the discussion in the preceding section about
which directories are involved) and open the directory.

3 Double-click the Ping MIB_Property.teel file.
4 Locate the SourceDirectory default path. (The line beginning with sourcebirectory = )

5 Change the path, replacing the existing path with the complete path name to the new
directory; begin the new path name just after the equals sign ( =).

) Leave the file filter as specified in the original SourceDirectory.

Export Directory

To change the default export directory, modify the export data process file. If you are making
this change before you install the package, you have to make this modification once, in the
Ping_MIB. ap directory. If you are making this change after you run Package Manager, you
must make this modification in two places:

® Ping MIB.ap

e (DPIPE_HOME}/scripts

Follow these steps to change the default export directory:

1 Inthe Ping MIB.ap directory double-click the Ping_MIB_exportdata.pro file.

2 Locate the three trend_export statements; beginning at the bracket after the -o, replace
the existing path with the complete path to the new directory.

3 Only if necessary, that is, only if you have already installed this package, navigate to the
{DPIPE_HOME} /scripts directory and make the same changes you made to
Ping_MIB_exportdata.pro.

Initializing Property Tables

You must initialize the property tables only if you are not already collecting data from the
Interface Reporting Basic Info MIBlet and the Cisco System MIBlet. The Action Poller UI will
show instance information only if the property table has been initialized. To initialize the
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property information, create a dummy poll that collects an instance of the designated MIBlets
from each interface on the nodes that you want to participate in Action Poller collections. The
easiest way to do this is to perform the following steps:

) Unless you are adding new nodes to a collection group, you must initialize the
property tables with the appropriate MIBlet instances for each new node that
you add.

1 Using the OVPI Polling Policy Manager, set up a view that contains all nodes that are to
participate in Action Poller collections.

2 Set up a dummy polling policy for that view.
3 Invoke the mw_collect utility from the command prompt with the following command:

mw_collect -i 15

) Replace “15” with the polling interval you chose when you created the
collection policy.

4 Deactivate the dummy polling policy after the mw_collect utility has completed the poll.

Action Poller Command Line Options

You can invoke the Action Poller from the command line or have trendtimer invoke it through
an entry in the trendtimer . sched file. The command has the following syntax:

action [-c child processes]
[-d debug level]
[-h]
-i polling interval
[-p port]
[-r retries)]
[-s round_factor]
[-t timeout]

[-V]
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The action command has the following options:

-c Specifies the number of concurrent child action poller processes
to run. The Action poller starts one child process for each node
pair. The processing power of the host determines the value
you specify for this option. The default is 20.

-d Debug level. Valid values are 0, 1, 2, and 3. The higher the
number, the more detailed the debug output. The default is O,
which means no debug output. Debug output is written to the
standard out. Keep in mind that any value other than 0 will
cause additional overhead.

-h Displays the command line options (help).

-i Polling interval. Each collection group that has the specified
polling interval will be collected during this invocation of the
Action poller.

-p Port number for SNMP sessions. The default is 161.

r The number of collection retries to attempt for each SNMP
session. The default is -1, which means the default number of
tries configured for SNMP.

-s This option rounds off the collection time (ta_period). If the
Action poller kicks off a collection at 3:07, and if you are using
the default collection option of 300 seconds (5 minutes), the
actual ta_period value for the collection will be recorded as

3:05.

-t The collection timeout, in seconds, for SNMP sessions. The
default is -1, which means the default timeout configured for
SNMP.

v Displays the version stamp for action.

This option is in UPPERCASE.

Changing the Collection Interval

When you install the Cisco Ping Report Pack, the following entry is placed in the
trendtimer.sched file:

15 - - {DPIPE_HOME}/trend_proc -f {DPIPE_HOME}/scripts/Ping MIB_poll.pro

This statement will execute all Cisco Ping collections every 15 minutes. To change the interval
for the collections from the default, simply change 15 to the desired interval. Here is what a
60-minute interval would look like:

60 - - {DPIPE_HOME}/trend_proc -f {DPIPE_HOME}/scripts/Ping_MIB_poll.pro

This change leaves all the node pairs in the same group, but modifies how often the collection
is performed. Do not make any changes through Polling Policy Manager. Currently, all
collections will be executed using the same time interval.
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Forms: Configure, Create, Update

This chapter provides samples of the following forms:
¢ Configure Collection Group

e Configure Device Pairs

e C(Create Device Pair Parameters

e Update Device Pair Parameters

e Update Threshold Values

Only two forms in this group, the Update Device Pair Thresholds form and the Update
Threshold Values form are accessible from the Management Console. Both of these forms are
context sensitive, which means that the only nodes you will be modifying are the nodes you
selected before launching the form. The other forms must be loaded using Report Builder or
Report Viewer.

To reach the Update Device Pair Parameters form or the Update Threshold Values form, click
the Objects icon on the left side of the Management Console. The Object Management window
opens, showing nodes along the left side of the window and various types of tasks listed down
the right side of the window.

e The Update Device Pair Parameter form is listed under General Tasks.
e The Update Threshold Values is listed under Object Specific Tasks.

See below for illustrations of all five forms.
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| C:4ovpit,packages'Ping_MIB! Ping _MIB.ap'Cisco_Pi =101 ]

Cisco Ping (ﬁﬂ

Configure Collection Groups

invent

A collection group contains a list of related Cisco Ping device pairs. This
farm can he used to create or update Cisco Ping collection groups. To
add or remove node pairs into a collection group use the "Cisco Ping
Configure Device Pairs" form.

Available Collection Groups

Group Hame Poller Hame Polling Interval
Gecocolection | [ oviht2 15
Cisco collection ovpihpt2 13

Caollection Group Hame |Ciscu collection

Poller Hame prihptz

Polling Interval |15

(] | fpply | Cancel |
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| C:ovpi',packages'Ping_MIB'Ping_MIB.ap'Cisco ng_form: e | |

Cisco Ping [ﬁﬂ

Configure Device Pairs PA——

Ilze this form to add new Cisco Ping device pairs to a Cisco Ping collection group. The new
device pair should he assigned interface and CPU instances and a parameter set. The
"iZigco Ping Collection Groups” form can be used to define new collection groups. Far
creating or updating the device pair parameters, use the "Create Device Pair Parameters”
and "Update Device Pair Parameters” forms, respectively.

Available Device Pairs

Choose for the selected Collection Group

Collection Group

Source Node Destination MNode
Cisco collection ll 156,962 156967
Cisco Ping Source |1 a.6.496.2 ll Cisco Ping Destination Idefault LI
%rc IF Instance IFastEthern etd :] Dst IF Instance IEI j
Src CPUInstance |t Dst CPU Instance J1

Pkt Cnt Pkt Size Pkt Timeout Delay
Src Parameters |1 - I 8 ' 100 _ 2000 _ il

Pkt Cnt Pkt Size Pkt Timeout Delay

Dst Parameters |1 - I ] [ 100 2000 o

8] 4 Apply Cancel
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ki C:.ovpi'packages'Ping_MIB"Ping_MIB.ap"Cisco_Ping_

=0l x|

Cisco Ping

Create Device Pair Parameters

[

invent

the newly created row,

LJze this form to create new device pair parameters. MNew parameter_id is automatically assigned for

parameter_id packet_count packet_size packet_timeout delay
' 1 i 5 100 2000 | ©
2 10 500 3000 50
Packet Count |5 Packet Size |1 00
Packet Timeout |znnu Packet Delay |n
) | aEnly Cancel
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Chapter 6

=10l x|

Cisco Ping
Update Device Pair Parameters

[

invent

LIse this form to update the device pair parameters. Please note that changing the an existing device
pair paramtere would affect all the existing device pair that use the updated device pair parameters.

parameter_id packet_count packet_size packet_timeout delay
1 5 100 2000 [ o
2 10 500 3000 50
Packet Count |5 Packet Size 100
Packet Timeout  [2000 Packet Delay |0
] | Ampls Cancel
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Update Threshold Values

h| C:'ovpitpackages'Ping_MIB'Ping_MIB.ap"Cisco_Ping

Threshold Values

Uze this form to update wvarious threshold values like Round Trip Time, Dizcard, Interface and CPU Threshold.

Source Destination Sample ID ATT Higtard Interrace cPY
Threshold Threshold Threshold Threshold
dafault ] 1,000,000 5 .00 £0.00 FO.00
156962 156967 1 1.000.00 500 £0.00 TF0.00
156.06.2 15.6.96 1 2 1.000.00 £.00 £0.00 TFoO.00
156967 15.0.152.2 3 1.000.00 500 £0.00 TF0.00
Source IdeTaurt
Destination |
Sample ID In
RTT Threshold |1 Joo.oa
Dizcard Threshold |5_|:||:|
CPU Threshold |s0.00
Interface Threshold I?D_DD
-
4] I _"I_I
0 apply | Cancel |
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Worst Performing Node Pairs

The Worst Performing Pairs report looks at yesterday’s activity and provides two views of
“worst”:

¢ Node pairs ranked by worst round trip time
¢ Node pairs ranked by worst packet delivery ratio

You may investigate any node pair in more detail by drilling down to yesterday’s hourly data
in the tabbed graphs and finding out exactly when RTT went up, or when the delivery ratio
went down, and whether these events took place when utilization was high or when
utilization was low.

The tabbed graphs track these metrics:

e Average hourly round trip time

e Hourly packet delivery ratio

e Source CPU utilization and destination CPU utilization

e Source interface utilization and destination interface utilization

RTT is measured in milliseconds; the delivery ratio is a percentage. A sample report follows.
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Worst Performing Node Pairs

invent

The Warst Performing Mode Pairs Repart provides separate charts ranking the warst peforming node pairs by round trip time (RTT) and by
packet delivery ratio respectively. Drilling down to either chart shows the detailed metrics for the node pair collected owverthe previous
day. Select a customer{left) and a node pair(right) to get the drill down information.

Worst Performing Hode Pairs, Ranked by Round Trip Time

Customers - . .
ol Hode Pair RTT Delivery Ratio

Unassigned Custamer amsterdam.desktalk.com -+ atlanta.desktalk .com 127.00 0234

sanjose. desktalk com -» sydney desktalk.com 19.00 9253

zanjose desktalk.com -> london.desktalk.com 12.00 ey |

sanjose desktalk.com -» chicago desktalk.com 12.00 s |

sanjose desktalk.com - > newyark deshtalk com 17.00 9295

zanjoze. deshktalk .com - > [aswegas deshtalk.com 15.00 9214

RTT | Delivery I CPU LHilization | Intertace Uil
Average Round Trip Time

amnsterdam . desktalk.com -» stlanta.deskialk.com
hdon Sep 30 12:00 A

146.10

97.40

ms

48.70

0
0000 000 0400 0600 0500 100D 1200 1400 1600  1&00 2000 2200

—dfwyg. RTT

Worst Performing Hode Pairs, Ranked by Packet Delivery Ratio
Mhan Sep 30 2002

Hode Pair RTT Delivery Ratio
=anjose desktalk.com - newyork desktalk.com 17.00 az.85
zanjose desktalk.com -+ london.deshtalk com 18.00 Evch |
sanjose desktall.com -+ chizago desktalk.com 12.00 Fa |
sanjose desktall.com -> sydney desktalk.com 18.00 9148
amsterdam.desktalk.com -+ atlanta.desktalk.com 127.00 9134
sanjose. desktalk com -¢ lasvegas desktalk.com 15.00 az2.14
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Daily QuickView/Daily Snapshot

The Daily QuickView provides a rolling daily summary. Constrained by customer, this report
highlights the node pairs with the highest round trip times for any given customer. This is a
rolling summary because it shows you how the baseline average and the F30 forecast are
changing from day to day.

The Daily Snapshot (not illustrated) is a subset of the Daily QuickView, but otherwise the
reports are identical. Open the Daily Snapshot and you will be able to select the node pairs
you want included in the report.

The list of node pairs at the top of the report indicates the average RTT and the delivery ratio.
Select a node pair to display the following graphs:

e Daily RTT and daily delivery ratio
e Baseline to F30 comparison for RTT and delivery ratio
e Hourly metrics for RTT, delivery, CPU utilization, and interface utilization

The QuickView shows latency and reliability metrics side by side. It also provides the context
you need to understand what the latency and reliability data points to. You can see whether
the packet delivery ratio is also affected, and you have the surrounding network in view. As a
result you now know whether poor ping test results are taking place when CPU and interface
utilization are higher than usual, lower than usual, or average.

A sample of the Daily QuickView follows.

47



Cisco Ping
QuickView

[

The Quiddfiew Report provides a ralling daily summary of 35th percentile round trip time values, or daily packet deliveny ratio for the
zelected customer(laffl and the node pairright). The Top 10 daily =amples for the zelacded node pair are displayed for the chosen
timeszpan, allowing the BT T Delivery metrics to be visually correlated with the coresponding CPU and inteface utilizations.

inwvent

Customers
All

Unassigned Customer

RTT | Delivery I

Round Trip Time - Daily 95th Percentile
sanjose desktalk.com -7 lasvegas . desktalk.com
Fri Sep 13 2002 - hion Sep 30 2002

26.10
17.40

a.70

Tue Sep 17 Tue Sep 24

Wo5% of Awg. RTT

Hode Pairs
zanjose.deddall.com -> lasvagas. deddalk. com
zanjose.desktalk.com -= sydney.desdalk.com
sanjose.desktalk.com -* london.desktalk.com
zanjose. desktalk.com -= chicago.desdalk.com
amsterdam.deshtalk.com -= atlanta.desdalk.com

zanjose.desktalk.com -= newnjok. deskdalk.com

RTT: BL & F30 | Delivery: BL & F30

Baseline & 30-Day Forecast RTT (P95)

sanjose. desktalk .com - 1aswegas desktalk.com
Fri Sep 13 2002 - Thu Sep 19 2002

26,60

g 12230

Sun Sep 15 Wred Sep 18

M Easeline Crelay
DSD-Day Forecast Delay

RTT | Deliveryl CPU Litilization | Interface LHil.

Top 10 Round Trip Time Samples for Selected Hode Pair
sanjose. desktalk .com - laswegas.deshktalk.com

fwban

Sep 30 12:00 M

19.00
2 g0 ‘ ‘ ‘ I \ |
u] t t t t t
0300 0500 o700 09:00 11:00 1300 1500 17.00 19:00 21:.00
M avg. RTT
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Sample Data in Near Real Time

Near Real Time provides access to sample data collected over the last six hours. This report is
available in two formats, QuickView and Snapshot. Use the QuickView when specific node
pairs are not of interest; use the Snapshot when you want to zero in on specific node pairs.

The NRT QuickView tells you which node pairs are reporting the highest number of threshold
breaches. The selection table lists node pairs, sorted highest count to lowest count, and also
lets you do a quick comparison of SLA breaches to non-SLA breaches. If you see a total that
causes concern, you can drill down on the node pair and take a closer look at:

e RTT over the last six hours

e Delivery ratio over the last six hours
e CPU utilization

e Interface utilization

This closer look will let you see actual breaches as well as near breaches. If the SLA breaches
are low, you should see utilization above the SLA Qualification Threshold; if the SLA breaches
are high, you should see utilization below the SLA Qualification Threshold.

A sample of the Thresholds NRT QuickView follows.
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QuickView - Near Real Time (/n

invent

The Quidfiew Hear Real Time Report displays the 95th percentile round trip time and packet deliveny ratio for the selected customer

(lefty and node pair(right) ower the ower the last six hours period and provides a wisual correlation with the corresponding CPU and
interface utilizations.

Customers Hode Pairs
All zanjose.deshtalk. com -= laswegas.desdalk.com
Unassigned Customer sanjose.desktall. com -= sydney.deskdalk.com

zanjose.deshtalk.com -= london.desktalk.com
zanjose.deshtalk.com -= chicago.desdalk. com
amsterdam.desktalk.com -» atlanta.deddalk.com

sanjose.deshtalk. com -= newno b, desdalk.com

RTT | Delivery |

Round Trip Time for Selected Hode Pair
zanjose . desktalk com - lagvagas desktalk.com
Tue Oct 01 06:52 Phd

2780

15.40

ms

9.20

1200 1230 1300 1330 1400 1430 1500 1530 1600 1630 1700 1730

—Aug. RTT

CPU Litlization | |nterface Liil.

CPU Wtilization for Selected Hode Pair
Tue Oct 01 0652 Phd

M0

.80 1

Percent

3.90 1

|:| n n n n n n n n n n 1
1200 1230 1300 1330 1400 1430 1500 1530 1600 1630 %00 1730 1§00

— CPU Lkilization : sanjose desktalk .com




Threshold Daily QuickView

The Threshold Daily QuickView provides a close-up view of yesterday’s performance, showing
which node pairs had the highest number of response time and discard breaches. Like the two
reports discussed in Chapter 8, this is a rolling summary because it calculates the baseline
average and the F30 forecast every day and shows how the baseline average and F30 forecast
are changing from day to day.

If you want to see how yesterday’s activity compares to recent activity, look at the RTT and
Delivery graphs. These graphs will tell you whether yesterday’s breach count was an isolated
incident or part of a trend that has been building over time. You will also see how the average
and P95 values compare to the threshold.

The baseline and F30 graphs show whether conditions are getting better or worse. You may
see a steady increase in the F30, a steady decrease, or little change. If you see a decrease in
the F30, then yesterday’s breach activity may be an isolated incident.

The tabbed graph at the bottom provides an hourly analysis of yesterday’s activity and tells
you exactly when performance crossed the threshold, causing a threshold breach to occur. If
these graphs indicate low utilization when the RTT or delivery breach took place, it’s likely

that SLA breaches took place.

A sample of the Threshold Daily QuickView follows.
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Performance Threshold Breaches -- Daily Quickview

O

inwvent

The Performance Thresholds Quiddiew Repart provides a ralling daily summarny of raund trip time walues, or daily padeet deliveny ratio for
the selected customer(lefty and the node paircright). The Top 10 dailw samples for the selected node pair are displayed for the chosen
timespan, allowing the RTT/Delivery metrics to be visually cormelated with the corresponding CPU and interface utilizations. RTT and
Deliwveny metrics are plotted against the provisioned thresholds allowing breaches or nearbreaches to be easily visualized. Fara RTT ar
Deliweny threshold breach to be considered a 'SLA' breach, the correlated CPU and Interface metrics must fall below the provisioned S0&
Qualification Thresholds.

Mode Pairs with the Highest Humber of Breaches

Customers hon Jan 2002007

£Ema . Tot RTT Tot Discard

Trinagy Hode Pairs Breach Breach
sanjose. dedtalk.com -» swdney. desdalk.com u} u]
sanjose. deddalk.com -» london.deskdalk. com a a
sanjoze.desktalk.com - chicago.desktalk.com ul o
sanjose. desidalk.com -> newnotedegtalk.com ul o
sanjose.desktalk.com -= lasvegas. desktalk.com ul u]

RTT l Dielivery I

Round Trip Time - Daiby
sanjose.desktalk.com -> sydney.desktalk.com
Tue Mow 05 2002 - Sun Dec 023 2002

RTT: BL & F30 | Delivery: BL & Fa0 |

Baseline & 30-Day Forecast RTT (P35)
sanjose . desktalk.com -+ sydney desktalk.com
Tue Mow 05 2002 - hdon Mow 11 2002

10.20 4,20
6.80 280
g w
E
s — -
1.40
1]
Tue Sun Sat Fri Thu Tue Sun [u]
Mow5 Now 10 Mow 16 MNow22 HovZ8 Dec3 DecS Tue iWed Thu  Fri  Sat Mon
How$S Mov Now7 Howd Hovd Mow 11
RTT (35th Percentile)
— RTT (frerage) W Eazeline Celay
— RTT (Threshold) DSD-Day Forecast Delay

RTT l Dielivery ] CPU Uilization | Interface L.

Round Trip Time for the Selected Hode Pair
sanjose.desktalk.com -+ sydney desktalk.com
Sun Dec 02 12:00 Al - Sun Dec 02 11:45 P

10,00

7.50

g soo

2.50

1)
sun sun sun Sun Sun Sun Sun Sun Sun Sun Sun

12000 A 0215 A 0430 AR 0545 AR 02:00 AW 11:15 A 0130 PM 03:45 PMW 0500 P 02315 P 10030 PW

—RTT
—RTT Thrashald
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Threshold Summaries

If you want to look more closely at breach counts on a customer by customer basis, and see
how SLA breaches compare to non-SLA breaches, use the two threshold summary reports.
These reports rank node pairs by breach count and indicate what your threshold settings are.
The daily version of the report is cumulative for yesterday’s activity, and the monthly version
is cumulative for the last 30 days. Both reports sort node pairs by threshold count, highest to
lowest.

The daily version has an Exception Details table that indicates when each breach took place.
If the node pair recorded 10 breaches yesterday, the Exception Details table will include 10
entries. Each entry in this table will tell you:

e The type of breach that occurred
e The average RTT in effect at that time
e The packet loss ratio in effect at that time

If the Exception Details table includes one or more SLA breaches, you can see what utilization
levels were in effect when that breach took place by looking at SLA Qualification Details. The
levels you see here will be low compared to the thresholds for CPU and interface utilization.

The monthly version of the report does not provide exception details or the data that justified
triggering an SLA breach. Instead, you have graphs that track increases and decreases in the
total SLA breach count and the total non-SLA breach count for RTT and delivery ratio.

Samples of the Threshold Breaches Summary report (Daily and Monthly) follow.
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Performance Threshold Breaches -- Daily Quickview

invent

The Pedformance Thresholds Quidkview Report provides a relling daily summary of round trip time walues, or daily packet deliverny ratio for
the selected customer(left) and the node pairfrighty,. The Top 10 daily zamples forthe selected node pair are displayed forthe chosen
timespan, allowing the RTT/Deliveny metrics to be visually correlated with the corresponding CPU and intedface utilizations. RTT and
CDelivery metrics are plotted against the provisioned thresholds allowing breaches or nearbreaches to be easily wisualized. Fara RTT ar
Creliveny threshold breach to be considerad a3 'SLA' breach, the comelated CPU and Interface metrics must fall below the provisioned 50L&
Qualification Threshaolds.

Hode Pairs with the Highest Number of Breaches
Thu Dec 19 2002

Customers
S Tot RTT Tot Discard
i Hode Pairs
Trinagy Breach Breach
zanjose.desktalk.com -= sydney. desdalk.com u] u}
sanjose.desktalk.com -= london.desdalk.com u] u}
zanjose.desdalk.com -= chicago.desktalk.com u] u}
zanjose.desddall.com -= newyotk.desktalk. com u] u}
zanjose.desddalk.com -= [aswegas. desktalk. com u] u}
RTT | Dielivery | RTT: BL & F30 | Delivery: BL & F30
Round Trip Time - Daily Bazeline & 30-Day Forecast RTT (P95)
zanjose.desktalk.com -5 sydney.desktal k.com zanjose. desktalk.com -+ sydney desktalk.com
Tue WNow 05 2002 - Sun Dec 08 2002 Tue Mow 05 2002 - hdon Mow 11 2002
10.20 ¢ 420 1
6.80 T a0 4
& L]
E E
2490 -
1.40 1
u] t + t
Fri How & Fri How 22 Fri Dech o L
ed Mow i Fri Mowd  Sun Now 10
RTT (94th Percentila)
— RTT (Awerage) W eazeline Delay
— RTT (Thrashald) DSD-Day Forecast Delay
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RTT | Deliveryl CPU UHilization | Interface L.

10.00

Round Trip Time for the Selected Hode Pair

sanjose.deshtalk.com -+ sydney desktalk.com
Sun Dec 02 12:00 21 - Sun Dec 02 11:45 P

Chapter 11

TA0 T

g 5007

2480 1

o000

0z:00

0400

0500

0z:00 10:00 12:00 14:00

—RTT

16:00

18:00

20:00

2Z:00
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Performance Threshold Breaches - Monthly Summary s

The Perdformance Threshold Breaches Manthly Summarny provides 3 monthly total of threshold breaches for every node pair. Thresholds on
the packet deliveny ratio and round trip time can be configured for each pair. In addition, the packet deliveny ratio and round trip time are
compared against the configurable minimum inteface and CPU utilization thresholds to show a service level agreement or S0A style
breach. Crilling doven fram the monthly summany shos daily packet deliveny ratio and round trip time breaches for a selected node pair
(middle table). Mode pairs are constrained by a selectable customer list (top table).

Customers
Acme

Trinagy

SLA Breach Counts for Last Month

Mo 2002
: Tot RTT Tot Delivery :
Hode Pair SLA-Breach Tot RTT Breach SLA.Breach Tot Delivery Breach

zanjose.destalk.com -= lasvegas. deddalk.com u] u} 10 10
zanjose.deskdalk.com -= sydney. desdalk.com u} u] u}

zanjose.deshtalk.com -= london.deshtalk. com u] u} u] u}
sanjose. deshtalk.com -* chicago.desktalk. com u} u] u} a
sanjose. desktalk.com -= newnot desdalk.com u] u} u] o
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&

RTT Breach | Packet Delivery i

Taotal

o017

Round Trip Time Breaches
sanjose . deshtalk.com -» laswegas desktalk .com
For Sat Mow 30 2002

Chapter 11

Fri Mow &

Tue Mow 12 Sat Mow 16 hed Mo 20

M Total RTT Hon-SLA-Breaches
Ef Total RTT SLA-Breaches

Sun Mo 24

Thia Monwe 28
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Executive Summary

If your network has users in various regions or users affiliated with various divisions of the
company, or if you are a service provider with customers, you are likely to be interested in
seeing performance aggregated by region, location, or customer. The Executive Summary
meets this need, allowing you to view a “rolled-up” version of performance data.

Instead of looking at performance for a particular node pair, the Executive Summary rolls up
performance for an entire region or an entire customer. Quick comparisons are now easy. The
division with high response time is easy to spot, and the customer with a low packet delivery
ratio is easy to spot.

The Executive Summary gives you an hourly view of the aggregation and a daily view of the
aggregation. The hourly view gives you an hour-by-hour analysis of response time and packet
delivery, while the daily view gives you a day-by-day view. If the hourly graph for yesterday
looks unusual, compare it to the daily. The comparison should provide the evidence you need
to determine whether or not yesterday’s activity was a temporary condition.

The two graphs for RTT, Hourly Aggregate and Daily Aggregate, show the divergence between
average RTT and P95 RTT. As mentioned earlier, the value for P95 is equal to or greater than
95% of the samples for a given day and reflects near-peak usage.

A sample of the Executive Summary follows.
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Executive Summary

[

inwvent

The Executive Summany Report provides haurly and daily aggregate peformance of the netwod across all node pairs owver the last
month, and ower the last day. Select a customer from the table below to wiew the aggregates of the 95th percentile round trip time and

the packet deliverny ratio.

Unazzigned Custamer

Daily Aggregate RTT (95th percentile)
Fri Sep 13 2002 - Mon Sep 30 2002

107 B0
80.70
5380
26,390

Tue Sep 17 Tue Sep 24

M g RTT (86th Percentile)

Hourly Aggregate RTT (95th percentile)
hion Sep 30 2002

136.40 1
102.30
2 B55.20

34.10 4

D 1
har 12:00 &M flan 12:00 P

FLarg RTT (95th Perzentile)

Daily Aggregate Packet Delivery Ratio
Fri Sep 13 2002 - hon Sep 30 2002

121.20

50.50

B0.60

30.30

Tue Sep 17 Tue Sep 24

W Pit Delivery Ratio

Hourly Aggregate Packet Delivery Ratio
hon Sep 30 2002

§32.80 T

5720 1

Percent

2560 1

D 1
flan 12:00 AmM fwlan 12:00 P

— Pht Delivery Fatio
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Forecasting Future Performance

The forecast report alerts you to node pairs that may be headed for performance problems. It
tells you which node pairs among all node pairs are expected to have the worst performance
30 days from now. Worst can refer to highest round trip time or lowest packet delivery ratio.

The forecast table beneath the customer list provides a list of node pairs and values for the
following metrics:

e 30 day forecast RTT

e Baseline RTT

e 30 day forecast delivery
e Baseline delivery

The 30 day forecast is a projection. Baseline RTT and baseline delivery are averages. If
performance has worsened over the baseline period, the 30 day forecast will be worse than the
baseline average; if performance has improved, the 30 day forecast will be better than the
baseline average.

The graphs below the forecast table do two things. They let you track daily increases and
decreases in P95 values (these are the values responsible for the projection), and they let you
see how the P95 value is diverging from the baseline average on a daily basis.

The value for P95 is equal to or greater than 95% of the samples for a given day. The value for
P95 reflects near-peak usage and functions as a reliable reflection of the conditions the
network is currently accommodating.

A sample forecast report follows.
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Forecast

O
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The Forecast Report provides a chart ranking the worst peforming pairs by daily round trip time or by total daily packet deliverny ratio, bazed

on 34 ueek projection extrapolated from G weeks of data.. Drilling down shows the data onwhich the forecast was bazed, at a daily level,

with the day-ofweek bazeline and 30-day forecast values, Select 3 customer (top table) and a node pairimiddle table), for the drill down

information. (NOTE: The RTT calculations are based on daily 95th percentile, providing a better basis for planning than either the average

or the peak)

Customers
Acme

Trinagy

Forecast -- Worst Performing Hode Pairs

DOwW

Sun

30-Day-Forecast Baseline 30-Day-Forecast Baseline
Hode Pair ) )
RTT RTT Delivery Delivery
amsterdam.deshtalk .com - > atlanta.desktalk com a9.71 it O 96.29 A6 .99
RTT | Delivery | RTT: BL w= F30 | Delivery: BL vs F30
Daily 95th Percentile Round Trip Time Round Trip Time -- Baseline vs 30-Day Forecast
amsterdam.desktalk.com -= atlanta.desktalk.com amsterdam desktal k.com = astlanta. desltal k.oom
Tue Mow D5 2002 - Sun Dec 09 2002 Tue Mow 06 2002 - hon Mov 11 2002
20.10 1432.70
53.40 8580
n
E E
47.90
2E.70
o
o Thu How 7 Sun Mo 10
Fri Mow 2 Fri Mow 22 Fri Dec B
i Mo i How i Dec [ Easeline Delay
—a5th Percentile : RTT [030-Day Forecast Delay
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MIB Variables and Summaries

This chapter provides a list of the variables that are polled from the following MIBs:
e (Cisco Ping MIB

e (Cisco System MIBlet

e Interface Reporting Basic Info MIBlet

The Cisco Ping MIB contains performance data for pings, the Cisco System MIBlet contains
CPU utilization data, and the Interface Reporting Basic Info MIBlet contains interface
utilization data.
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Cisco Ping MIB

The source MIB is the Cisco-Ping-MIB. The source table is Risco_ping_rtd. The following table

provides a list of variables, with descriptions.

Variable

OID String

Description

avg_rtt

1.3.6.1.4.1.9.9.16.1.1.1.12

Average round trip for all the packets
that have been sent in this sequence.
This object will not be created until the
first ping response in a sequence is
received.

max_rtt

1.3.6.1.4.1.9.9.16.1.1.1.13

Maximum round trip for all the
packets that have been sent in this
sequence. This object will not be
created until the first ping response in
a sequence is received.

min_rtt

1.3.6.1.4.1.9.9.16.1.1.1.11

Minimum round trip for all the
packets that have been sent in this
sequence. This object will not be
created until the first ping response in
a sequence is received.

packets_received

1.3.6.1.4.1.9.9.16.1.1.1.10

Number of ping packets that were
received from the target in this
sequence.

packets_sent

1.3.6.1.4.1.9.9.16.1.1.1.9

Number of ping packets that were sent
to the target in this sequence.

packet_size

1.3.6.1.4.1.9.9.16.1.1.1.5

Size of ping packets to send to the
target in this sequence. The lower and
upper boundaries of this object depend
on the protocol. An instance of this
object cannot be modified unless the
associated instance of
ciscoPingProtocol has been created (to
allow protocol-specific range checking
on the new value).
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cisco_system MiBlet

Chapter 14

The source MIBlet is cisco_system. The source table is xcpu_util_rtd_png_.

Variable

OID String

Description

avg_busyl

1.3.6.1.4.1.9.2.1.57

1 minute exponentially-decayed moving
average of the CPU busy percentage.
Changed from INTEGER to Gauge by HP
OpenView.

interface-reporting_basic_interface_info MiBlet

The source MIBlet, basic_interface_info, is a miblet of the MIB-II ifEntry table. The source
table is interface_rtd_png._.

Variable

OID String

Description

ifSpeed

1.3.6.1.2.1.2.2.1.5

Estimate of current bandwidth in bits per
second. If the interface does not vary in
bandwidth, or if an accurate estimate is
not possible, this object should contain
the nominal bandwidth.

ifInOctets

1.3.6.1.2.1.2.2.1.10

Total number of octets received on the
interface, including framing characters.

ifOutOctets

1.3.6.1.2.1.2.2.1.16

Total number of octets transmitted out of
the interface, including framing
characters.
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Summaries

Summaries

Collected data is summarized on an hourly, daily, and monthly basis.

Summary What It Aggregates

PingDaily_bykey.sum Hourly data for all device pairs by day and by key.
PingHourly_bykey.sum Rate data for all device pairs by day and by key.
PingDaily_allpairs.sum Hourly data for all device pairs by day.
PingHourly_allpairs.sum Rate data for all device pairs by hour.

PingHourly_allpairs_by_cust_id.sum | Rate data for all device pairs by hour and by
cust_id.

PingDOW_BL_and_FC_bykey.sum Rate data for all device pairs by day of week and by
key.

Baseline and Forecast Data

The source table is SD425Dcisco_ping_rtd_SBF_cisco. trendsum calculates the values for the
variables and stores them in this table.

Variable OID String |Description

day_of_week 6 This string value notes the day of the week
for the collected data.

F30avg_rtt 5 30-day forecast average for round trip delay
times.

F30packets_received 3 30-day forecast for packets received.

F30packets_sent 1 30-day forecast for packets sent.

WAVavg_rtt 4 Weighted average for round trip delay times.

WAVpackets_received |2 Weighted average for packets received.

WAVpackets_sent 0 Weighted average for packets sent.
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Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate,
you can easily change to a different view. If you are using Report Viewer, display view options
by right-clicking the object. If you are using the Web Access Server, follow these steps to
change the default view:

1

2
3
4
5

6

Click Preferences on the links bar.
Expand Reports in the navigation frame.
Click Viewing.

Select the Allow element editing box.

Click Apply.

Click # (the Edit icon) next to the table or graph.

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server,
opens a list of table view options.

Sek Time Feriad,.
Change Constraink Values, ..

Select Modes[Interfaces...

Change Max Rows. ..

View in new Frame

Print Table. ..
Expart Element as C3Y,..

Delete Table

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days
or to 7 days. If you are interested in a specific period of time that starts in the past and stops
before yesterday, click Use Absolute Time and select a Start Time and an End Time.
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View Options for Tables

=i

Direction
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input
Input

[y

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering
the number of elements that conform to the constraint. The Change Constraint Values
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node
Selection Type window opens.

Change Max Rows increases or decreases the number of rows in a table. The default is 50. If
you expand the default, the table may take more time to open. If you are trending a large
network, using the default ensures that the table opens as quickly as possible.

View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make
the data in the table more legible by resizing the window.

Polled IP QoS Statistics Data - Input
Orver Previous 6 Hours
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Chapter 15

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server,
opens the following list of view options.

Add | Sverla. .

Remove Overlay

Set Time Period...
40000 1 Zhange Constraint Yalues. ..

Seleck Modes/Interfaces. ..

32T 20 1 Displayed Data

| arid
Legend
Skyle

294540 1

- v v

163.60 T “hange Max Rows. .

Display Dakta Table
21.80 1 [
Export Element as C5Y, ..

Display: Cerlay Mata Table

0

Sep: 17 Sep: 24 Sep: o5 Sep: =0 Export Graph Swerlay Data as T,
Wiew in new Frame
Print Graph. ..
[elete Graph

The following table provides details about each option.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a
spreadsheet.

Grid Add these to the graph:

X axis grid lines
Y axis grid lines

X and Y axis grid lines
Legend Delete or reposition the legend.
Style See the illustrations below.
Change Max Rows... Same as the table option shown above.
Display Data Table See below.
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View Options for Graphs

Option Function

Export Element as CSV... Same as the table option shown above.
View in New Frame Opens graph in a Graph Viewer window.
Print Graph Same as the table option shown above.

Style Options

Select Style to display a list of seven view options for graphs.

[T

Set Time Period. ., 43 s

Change Canstraink Yalues., ..

Select Modes/Interfaces, .,

Displayed Data b % !
Grid ¥
Leqend ) A
| Skyle frea
Change Max Rows. .. Stacking Area
Cisplay Data Table Bar
Export Element as C5Y. .. Stacking Bar
Display: Grerlay Daka Table Pie:
Expart Graph @wverlay Daka as C54 ., # Plat
Wigw in new Frame Scatter Plok
Prink &raph. .. Airle N e
Delete Graph Hi-Lo-Open-Close —
- ~rom  Cande
Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are
easy to view in this format, absolute values for smaller data types may be hard to see. Click
anywhere within a band of color to display the exact value for that location

TrEaou +

9560

olurne

7170 1

Sat Feb 24 06:00 &AM EST
Mormal Disconnect (107 js 74.00

s

oA } } } } } } }
04:00 0E:00 0300 10:00 12:00 1400 16:00 1800 20:00 2200
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Chapter 15

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to
highlight the time span you want to focus on. Release the mouse button to display the selected
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a
small number of variables.

% 200.00

1E80.00
120.00
20.00

40.00

u]
hon 01 Tue 02 Wed 03

M g Utilization (H)
I 0 2 Utilization (Ha
M Util Threshold

Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values
for a small number of variables. There are three variables in the graph below.

14,924.00 -
9,539 .20
7,154.40

4,769 50

Forecast Minutes

2,364 80

Tho 01 Fri 0Z Sat 03 Sun 04 hon 05 Tue 06 ied OF
D=ys Of The Wieek
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View Options for Graphs

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame,
the time scale becomes hourly. If you increase the height of the frame, the call volume shows
in units of ten.

200.00
160.00
120.00
20.00
40.00

hon 01 Tue 02 Wead O3

M 2oeq Utilization (H)
I 1z Utilization ¢H)
M Uil Threshald

Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make
the data points align with hour; if you adjust the frame height, you can turn call volume into
whole numbers.

7850 1

E2.80 1 ﬂ
4710 1 [ M W

3140 1

1870 1

hon 01 Tue 02 Wed 03

— forg WMilization (H)
— hlax Utilization (H)
— Wil Threshald
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Chapter 15

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the
pie constitutes a 24-hour period. This view is helpful when a small number of data values are
represented and you are looking at data for one day.

M Under 1 minute

Epetween 1 and § minutes

O Between & and 30 minutes

O Betwesn 20 minutes and 2 hours
M Batween 2 hours and 12 hours
M Qver 12 hours

If you are looking at data for more than one day, you will see multiple pie graphs, one for each
day.

Display Data Table

This option changes a graph into a spreadsheet.

1o/
X Axis I Average I

Tue Feb 12.., 0,509

Tue Feb 12.., 0,621

Tue Feb 12.., 1.0z6

Tue Feb 12.., 0,362

Tue Feb 12.., 1.171

Tue Feb 12.., 1.051

Tue Feb 12.., 0.254

Tue Feb 12.., 0.8z6

Tue Feb 12.., 1.4583 [:.S

Tue Feb 12.., 0,9:7

Tue Feb 12.., 1.471

Tue Feb 12.., 1,305

Tue Feb 12.., 1.1z23

Tue Feb 12.., 0,93

Tue Feb 12.., 1.497

Tue Feb 12.., 0,306

Tue Feb 12.., 0,725
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View Options for Graphs

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window.

2% Graph Yiewer =0l x|
Metwork Response Time
Cisco_04

Tue Feb 19 12:00 Al - Tue Feb 19 14:00 P

Seconds

Tue 05:00 AM Tue 11:00 PM
— Awerage
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glossary

availability

The percentage of time a device has been operational. Identifies device outages as reported through
the sysUpTime variable. Calculated by combining device sysUpTime with interface ifOperStatus
and interface ifLastChange.

avg volume

This metric is found in capacity planning reports. It refers to average daily volume during the
baseline period. F30 Volume is the 30 day forecast for daily volume.

baseline busy hour

The average of 42 busy hour values recorded during the rolling baseline period. This value appears
in the Capacity Planning report as Avg BH Util, or Average Busy Hour Utilization.

busy hour

The one hour of the day when utilization was higher than the other 23 hours in the day. Do not
confuse busy with peak. Busy hour is an average, an average of four samples. Any sample within
that collection of four samples may have been well above or well below the average. The busy hour
average is treated as a persistent event suitable for use in calculations that project future
performance levels.

daily

A view showing daily performance for the previous 30 days, The most recent day in this view shows
performance for yesterday.

day of week

A forecast, derived from baseline data, that correlates growth rate to each day of the week.

device
Any SNMP manageable device.

discard rate

The percentage of packets discarded by the interface. Data about discards is sampled during each
poll cycle (by default this is four times an hour); based on those samples, OVPI calculates an
average and a maximum discard rate.
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discard threshold

The point at which an acceptable percentage of discarded traffic becomes an abnormal percentage
and possibly impacts the user experience. If the interface is full duplex, the same threshold value is
applied to both in and out packets separately.

error rate

The percentage of packets with errors as reported by the interface. Data about errors is sampled
during each poll cycle (by default this is four times an hour); based on those samples, OVPI
calculates an average and a maximum error rate.

error threshold

The point at which an acceptable percentage of errored traffic becomes an abnormal percentage
and possibly impacts the user experience. If the interface is full duplex, the same threshold value is
applied to both in and out packets separately.

F30/F60/F90

The level where utilization (or volume) is expected to be 30, 60, and 90 days from now. Calculated
by applying linear regression to busy hour levels over the baseline period.

group
This value is imported by the provisioning interface. If this value is not provisioned, the report
shows unknown in this field.

growth rate

F30 utilization divided by average busy hour.

hourly

A view showing performance for the last two days and whatever portion of today has elapsed. The
minimum time range is 48 hours; the maximum is 72 hours.

interface

An entry in the SNMP ifTable for of the device. Can represent a physical or logical interface.

monthly

A view showing performance for each month over the last two years. Blank until data collection has
been functioning for at least one month.

region

This value is imported by the provisioning interface. If this value is not provisioned, the report
shows unknown in this field.

response time

Delay within the network management structure, specifically, delay between the datapipe and the
device. If the delay is being caused by the device, then this value may point to device resource
issues.
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threshold breach

The line between normal and abnormal performance. When this line is crossed, an exception is
recorded. Every threshold has a default value that is easily changed to reflect individual needs.

utilization

The total number of octets traversing the interface as a percentage of the total possible number of

octets, using the ifSpeed property. If an interface is full duplex, utilization is calculated and
displayed separately in each direction. Groups of interfaces have their utilization calculated by
taking the total traffic on all administratively up interfaces in the group and dividing that by the
total possible bandwidth for those interfaces. Utilization for a group of interfaces is more
meaningful when all the interfaces in the group use the same protocol.

utilization threshold

The point at which the number of octets traversing the interface is considered detrimental to the
service level required by network users. In the case of full duplex interfaces, the same threshold
value is applied to both in and out packets separately.
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ActionDatapipe, 37

Action Poller
adding a new collection group, 27
changing an existing parameter set, 29
changing the collection interval, 37
command line option, 36
defining node pairs, 28
invoking, 27
node pair properties, 28
removing node pairs, 28

Add Database Wizard, 31
adding a collection group definition, 27

avg volume, 75

B

baseline busy hour, 75
basic_interface_info (MIBlet), 65
busy hour, 75

C

capacity planning, 7

change max rows option, 69
cisco_system MIBlet, 29

Cisco Ping MIB, 10

Cisco System MIBlet, 10

collection group, 29

Configure Collection Group form, 39
Configure Device Pairs form, 39

Create Device Pair Parameters form, 39

customer-specific reports, 12

D
daily, 75
day of week, 75

demo package, 13, 17,23
deploying reports, 25
destination MIBlet instance, 29
destination node, 30
device, 75

discard exceptions, 8
discard rate, 75

discard threshold, 76
Display Data Table, 69
displayed data option, 69
distributed systems, 16, 22
dummy polls, 36

E

error messages, 11
error rate, 76
error threshold, 76

F

F30, 76

F60, 76

Fo0, 76

forms
Configure Collection Group, 39
Configure Device Pairs, 39
Create Device Pair Parameters, 39
Update Device Pair Parameters, 39
Update Threshold Values, 39

G

graph view options, 67
grid options, 69

group, 76

group filters, 12
growth rate, 76
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hourly, 76
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ifInOctets (variable), 65

ifOutOctets (variable), 65

ifSpeed (variable), 65

initializing property tables, 35
interface, 76

interface_rtd_png_, 28

interface aggregations, 32

Interface Discovery Datapipe, 21, 23
Interface Reporting Basic Info MIBlet, 10
IR_DevPort_Hourly_Process.pro, 32
IR ifEntry Datapipe, 21

L
legend options, 69

M

MIBs
Cisco Ping MIB, 10
Cisco System MIBlet, 10
Interface Reporting Basic Info MIBlet, 10

MIB variables
cisco_system MIBlet, 65
Cisco Ping MIB, 64
interface-reporting_basic_interface_info MIBlet,
65

monthly, 76

mw_collect, 36

(o)

OVPI Timer
starting, 18

P
packet delivery ratios, 10

packets_received, 64
packets_sent, 64

parameters
delay, 30
packet count, 30
packet size, 30
packet timeout, 30

Ping MIB_Thresholds, 18
polling interval, 37
polling policy, 36

port number, 37

Product Manuals Search page, 13

R

remove node pair, 28
report parameters, 12
response time, 76
round trip time, 64

route availability, 11

S
satellite servers, 32
SNMP SET request, 10

source
MIB, 64
table, 66

SourceDirectory path, 35

source instance of each MIBlet, 29
source MIBlet instance, 29

style options for graphs, 69

summaries
PingDaily_allpairs.sum, 66
PingDaily_bykey.sum, 66
PingDOW_BL_and_FC_bykey.sum, 66
PingHourly_allpairs.sum, 66
PingHourly_allpairs_by_cust_id.sum, 66
PingHourly_bykey.sum, 66

system clocks, 32

T
table view options, 67

TEEL files, 34

threshold, 77

Threshold Breaches Summary, 53
Threshold Daily QuickView, 51

thresholds
discard, 76
error, 76
Threshold Breaches Summary, 53
Threshold Daily QuickView, 51
Thresholds NRT QuickView, 49
utilization, 77
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Thresholds NRT QuickView, 49
trend.log, 11
trendcopy, 32

trendtimer, 32

U

unavailable route, 11

unknown, 32

unsuccessful pings, 11

Update Device Pair Parameters form, 39
Update Threshold Values form, 39
UPGRADE_Ping MIB_3_to_4, 18

Use Absolute Time, 67

utilization, 77

utilization threshold, 77
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view in new frame, 68

X
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